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OBJECTIVES 

 

 

 

 

 To  know about the computers and its characteristics. 

 To learn MS word and its usages 

 To learn about Ms Excel and its Applications 

 To learn Power point  and its uses 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ALLIED COURSE – I 



 

 

PC PACKAGES - I with practical’s  (Theory & Practicals) 

Objectives: To learn about Computers and to gain practical knowledge and application 

in Business.(Theory - 60 marks ; UE: 45 ; IA: 15) 

 

Unit I: 

Introduction to computers – Meaning – Characteristics – Areas of Application – Components 

of Computer – Memory and control units – Input and Output devices – Hardware and 

Software – Operating Systems 

Unit II: 

Word – Creating Word Documents – Creating Business Letters using wizards – Editing 

Word Documents – Inserting Objects – Formatting documents –spelling and grammar check 

– Word Count, Thesaurus, Auto Correct – Working with tables – Saving, opening, closing 

and protecting documents – Mail Merge. 

Unit III: 

Introduction to Spread Sheet (MS –Excel) – Introduction to spread sheets – entering and 

editing text, numbers and formulae – Inserting rows and columns Building Worksheets – 

Creating and formatting charts – Application of Financial and Statistical functions – MS 

Power Point Creating a simple presentation – Creating, inserting and deleting slides – Saving 

a Presentation.  

 (Practical – 40 marks UE: 30 marks IA: 10 marks) 

Unit IV: 

Word – Creating personal letters – Official letters – circulars – templates – Use of Wizards – 

Resumes – Preparation of Bio-data – Creating Greetings – Clip Art – Bullets and Numbering 

– Insertion of charts and diagrams – Tables – Mail merge. 

Unit V: 

Excel – Entering information in worksheet - Sum functions – Align data cells – Changing 

column width and row height – Pay bill – mark sheet – Electricity bill – Pay slip – 

PowerPoint – Simple presentations – creating slide show – animation – inserting and deleting 

slides. 

Text and Reference Books (Latest revised edition only) 

1. E.D. Jones and Derek “Microsoft Office for Windows”, Sutton Publication. 

2. Sanjay Saxena, “MS Office 2000” Vikas Publishing House. 

3. S.V. Srinivasa Vallabhan,“Computer Applications in Business” Sultan Chand and Sons, 

4. TD Malhotra, Computer Applications in Business Kalyani PublicationsPC 

5. Taxali, “Software for windows made simple” Tata McGraw Hill Publishing Company 



 

 

 

PC PACKAGES – I 

UNIT I 
 

Introduction to Computers 

 A computer is an electronic data processing device, which accepts and stores data input, processes the data 

input, and generates the output in a required format. 

Functionalities of a Computer 

Any digital computer carries out the following five functions − 

Step 1 − Takes data as input. 

Step 2 − Stores the data/instructions in its memory and uses them as required. 

Step 3 − Processes the data and converts it into useful information. 

Step 4 − Generates the output. 

Step 5 − Controls all the above four steps. 

 

Characteristics of Computers 

Following are certain characteristics of computers. 

1. High Speed 

 Computer is a very fast device. 

 It is capable of performing calculation of very large amount of data. 

 The computer has units of speed in microsecond, nanosecond, and even the picosecond. 

 It can perform millions of calculations in a few seconds as compared to man who will spend many 

months to perform the same task. 



 

2. Accuracy 

 In addition to being very fast, computers are very accurate. 

 The calculations are 100% error free. 

 Computers perform all jobs with 100% accuracy provided that the input is correct. 

3. Storage Capability 

 Memory is a very important characteristic of computers. 

 A computer has much more storage capacity than human beings. 

 It can store large amount of data. 

 It can store any type of data such as images, videos, text, audio, etc. 

4. Diligence 

 Unlike human beings, a computer is free from monotony, tiredness, and lack of concentration. 

 It can work continuously without any error and boredom. 

 It can perform repeated tasks with the same speed and accuracy. 

5. Versatility 

 A computer is a very versatile machine. 

 A computer is very flexible in performing the jobs to be done. 

 This machine can be used to solve the problems related to various fields. 

 At one instance, it may be solving a complex scientific problem and the very next moment it may be 

playing a card game. 

6. Reliability 

 A computer is a reliable machine. 

 Modern electronic components have long lives. 

 Computers are designed to make maintenance easy. 

7. Automation 

 Computer is an automatic machine. 

 Automation is the ability to perform a given task automatically. Once the computer receives a 

program i.e., the program is stored in the computer memory, then the program and instruction can 

control the program execution without human interaction. 

8. Reduction in Paper Work and Cost 

 The use of computers for data processing in an organization leads to reduction in paper work and 

results in speeding up the process. 



 

 As data in electronic files can be retrieved as and when required, the problem of maintenance of 

large number of paper files gets reduced. 

 Though the initial investment for installing a computer is high, it substantially reduces the cost of 

each of its transaction. 

Disadvantages of Computers 

Following are certain disadvantages of computers. 

No I.Q. 

 A computer is a machine that has no intelligence to perform any task. 

 Each instruction has to be given to the computer. 

 A computer cannot take any decision on its own. 

Dependency 

 It functions as per the user’s instruction, thus it is fully dependent on humans. 

Environment 

 The operating environment of the computer should be dust free and suitable. 

No Feeling 

 Computers have no feelings or emotions. 

 It cannot make judgment based on feeling, taste, experience, and knowledge unlike humans. 

Computer - Applications 

Business 

 

A computer has high speed of calculation, diligence, accuracy, reliability, or versatility which has made it 

an integrated part in all business organizations. 

Computer is used in business organizations for − 

 Payroll calculations 

 Budgeting 

 Sales analysis 

 Financial forecasting 

 Managing employee database 

 Maintenance of stocks, etc. 

Banking 

 



 

Today, banking is almost totally dependent on computers. 

Banks provide the following facilities − 

 Online accounting facility, which includes checking current balance, making deposits and overdrafts, 

checking interest charges, shares, and trustee records. 

 ATM machines which are completely automated are making it even easier for customers to deal with 

banks. 

Insurance 

 

Insurance companies are keeping all records up-to-date with the help of computers. Insurance companies, 

finance houses, and stock broking firms are widely using computers for their concerns. 

Insurance companies are maintaining a database of all clients with information showing − 

 Procedure to continue with policies 

 Starting date of the policies 

 Next due installment of a policy 

 Maturity date 

 Interests due 

 Survival benefits 

 Bonus 

Education 

 

The computer helps in providing a lot of facilities in the education system. 

 The computer provides a tool in the education system known as CBE (Computer Based Education). 

 CBE involves control, delivery, and evaluation of learning. 

 Computer education is rapidly increasing the graph of number of computer students. 

 There are a number of methods in which educational institutions can use a computer to educate the 

students. 

 It is used to prepare a database about performance of a student and analysis is carried out on this 

basis. 

Marketing 

In marketing, uses of the computer are following − 

 



 

 Advertising − With computers, advertising professionals create art and graphics, write and revise 

copy, and print and disseminate ads with the goal of selling more products. 

 Home Shopping − Home shopping has been made possible through the use of computerized 

catalogues that provide access to product information and permit direct entry of orders to be filled 

by the customers. 

Healthcare 

Computers have become an important part in hospitals, labs, and dispensaries. They are being used in 

hospitals to keep the record of patients and medicines. It is also used in scanning and diagnosing different 

diseases. ECG, EEG, ultrasounds and CT scans, etc. are also done by computerized machines. 

Following are some major fields of health care in which computers are used. 

 

 Diagnostic System − Computers are used to collect data and identify the cause of illness. 

 Lab-diagnostic System − All tests can be done and the reports are prepared by computer. 

 Patient Monitoring System − These are used to check the patient's signs for abnormality such as in 

Cardiac Arrest, ECG, etc. 

 Pharma Information System − Computer is used to check drug labels, expiry dates, harmful side 

effects, etc. 

 Surgery − Nowadays, computers are also used in performing surgery. 

Engineering Design 

Computers are widely used for Engineering purpose. 

One of the major areas is CAD (Computer Aided Design) that provides creation and modification of 

images. Some of the fields are − 

 

 Structural Engineering − Requires stress and strain analysis for design of ships, buildings, budgets, 

airplanes, etc. 

 Industrial Engineering − Computers deal with design, implementation, and improvement of 

integrated systems of people, materials, and equipment. 

 Architectural Engineering − Computers help in planning towns, designing buildings, determining a 

range of buildings on a site using both 2D and 3D drawings. 

Military 

 

Computers are largely used in defence. Modern tanks, missiles, weapons, etc. Military also employs 

computerized control systems. Some military areas where a computer has been used are − 



 

 Missile Control 

 Military Communication 

 Military Operation and Planning 

 Smart Weapons 

Communication 

Communication is a way to convey a message, an idea, a picture, or speech that is received and understood 

clearly and correctly by the person for whom it is meant. Some main areas in this category are − 

 

 E-mail 

 Chatting 

 Usenet 

 FTP 

 Telnet 

 Video-conferencing 

Government 

Computers play an important role in government services. Some major fields in this category are − 

 

 Budgets 

 Sales tax department 

 Income tax department 

 Computation of male/female ratio 

 Computerization of voters lists 

 Computerization of PAN card 

 Weather forecasting 

 

 

 

Components of a Computer System 



 

 

Input Unit 

This unit contains devices with the help of which we enter data into the computer. This unit creates a link 

between the user and the computer. The input devices translate the information into a form understandable 

by the computer. 

Output Unit 

The output unit consists of devices with the help of which we get the information from the computer. This 

unit is a link between the computer and the users. Output devices translate the computer's output into a form 

understandable by the users. 

CPU(Central Processing Unit) 

Central Processing Unit (CPU) consists of the following features − 

 CPU is considered as the brain of the computer. 

 CPU performs all types of data processing operations. 

 It stores data, intermediate results, and instructions (program). 

 It controls the operation of all parts of the computer. 

 

CPU itself has following three components. 

 Memory or Storage Unit 

 Control Unit 

 ALU(Arithmetic Logic Unit) 

 

Memory or Storage Unit 

This unit can store instructions, data, and intermediate results. This unit supplies information to other units 

of the computer when needed. It is also known as internal storage unit or the main memory or the primary 

storage or Random Access Memory (RAM). 



 

Its size affects speed, power, and capability. Primary memory and secondary memory are two types of 

memories in the computer. Functions of the memory unit are − 

 It stores all the data and the instructions required for processing. 

 It stores intermediate results of processing. 

 It stores the final results of processing before these results are released to an output device. 

 All inputs and outputs are transmitted through the main memory. 

Control Unit 

This unit controls the operations of all parts of the computer but does not carry out any actual data 

processing operations. 

Functions of this unit are − 

 It is responsible for controlling the transfer of data and instructions among other units of a computer. 

 It manages and coordinates all the units of the computer. 

 It obtains the instructions from the memory, interprets them, and directs the operation of the 

computer. 

 It communicates with Input/Output devices for transfer of data or results from storage. 

 It does not process or store data. 

ALU (Arithmetic Logic Unit) 

This unit consists of two subsections namely, 

 Arithmetic Section 

 Logic Section 

Arithmetic Section 

Function of arithmetic section is to perform arithmetic operations like addition, subtraction, multiplication, 

and division. All complex operations are done by making repetitive use of the above operations. 

Logic Section 

Function of logic section is to perform logic operations such as comparing, selecting, matching, and 

merging of data. 

 

Classification of Computers 

There are three major categories based on which computers can be classified. These are: 

1. Based on Size 



 

2. Based on Purpose 

3. Based on Types 

The image given below gives a clear classification of the Types of Computers: 

 

Further in this article, we shall discuss in detail the above-mentioned types of computer in detail for 

candidates to understand them easily and efficiently. 

Types of Computer-Based on Types 

The three types of computers along with their functions are given below: 

 Analog Computer – An analog computer one that uses the continuously changeable aspects of 

physical phenomena to model the problem being solved. These phenomena may be such as electrical, 

mechanical, or hydraulic quantities and they are extremely complex to be used. Such computers are 

mostly used for scientific and industrial applications. Examples of Analog computers include 

Thermometer, Operational Amplifiers, Electric Integrators, etc. 

 Digital Computer – Such computers are capable of solving problems in discrete format. It only 

operates on data entered in binary language and can perform the dynamic function of managing large 

amounts of data and regulating the operations of the machine, Examples of Digital computers are 

Desktop, Laptop, Mobile Phones, etc. 

 Hybrid Computer – Computers that exhibit features of both Analog and Digital computers are 

called Hybrid Computers. The logical operations are solved by the digital aspects and the differential 

equations are solved using the analog features. Few important examples of Hybrid Computers 

include Space Flights, Food processing Plants, etc.  

Types of Computers – Based on Size 

Described below are the four types of Computers based on their sizes along with their functions: 



 

 Micro Computers – A relatively inexpensive and small computer comprising a microprocessor and 

a Central Processing Unit (CPU) is called a Microcomputer. Such computers are made with minimal 

circuitry mounting over a single circuit board. Examples include Desktop, Laptop, etc. 

 Mini Computer – Developed in the mid-1960s, Mini computers are comparatively smaller than 

mainframe computers. They were developed keeping in consideration human interaction, control 

instrumentation and were cost-effective. For example Smartphones, iPads, etc. 

 Mainframe Computer – Computers used by large Organisations to manage bulk data are called 

Mainframe computers. Main functions of such type include managing customer statistics, census and 

other heavy data in a single device. For example, the system used at Trading companies. 

 Super Computer – Computers used at Organisations dealing with Weather forecasting, Quantum 

Mechanics, Climate research, etc., where high level of performance has to be justified are called 

Super Computers. 

Apart from the Computer Awareness section, candidates can also get the detailed subject-wise syllabus for 

various Government exam in the table given below: 

Types of Computer – By Purpose 

On the basis of purpose, there are just two variety of computers. Those two varieties have been discussed in 

detail below: 

1. General Purpose – Based on General Purpose, there are these following functions which a device is 

expected to perform: 

1. Basic Input/Output functions 

2. Calculations 

3. Data Saving on a smaller scale 

4. General performing activities 

These may include basic calculators, laptops, desktop computers, mobile phones, etc., which can help people 

with their basic necessary functions are included in the General Purpose computer type. 

 Special Purpose – When a computer is designed specifically to perform a certain function, such type 

of computers is known as Special Purpose computer. These types may include: 

1.  

1. Thermometers to test temperature 

2. Generators to manage electricity 

3. Devices used for analysing Climate Change 

4. Large computers for IT Companies 

5. Machines used at Manufacturing Units and the list goes on and on 



 

The special-purpose computers are important for various Organisations and their applications are made in a 

way that makes the work easy and efficient.  

Generations of Computers 

There are five generations of computers.  

First Generation:  

 1946-1959 is the period of first generation computer. 

 J.P.Eckert and J.W.Mauchy invented the first successful electronic computer called ENIAC, 

ENIAC stands for “Electronic Numeric Integrated And Calculator”. 

Few Examples are: ENIAC, EDVAC,UNIVAC,IBM-701,IBM-650 

Advantages:  

1. It made use of vacuum tubes which are the only electronic component available during those days.  

  

2. These computers could calculate in milliseconds.  

  

Disadvantages:  

1. These were very big in size, weight was about 30 tones. 

2. These computers were based on vacuum tubes. 

3. These computers were very costly. 

4. It could store only a small amount of information due to the presence of magnetic drums.  

5. As the invention of first generation computers involves vacuum tubes, so another disadvantage 

of these computers was, vacuum tubes require a large cooling system. 

6. Very less work efficiency. 

7. Limited programming capabilities and punch cards were used to take inputs. 

8. Large amount of energy consumption. 

9. Not reliable and constant maintenance is required. 

Second Generation 

 1959-1965 is the period of second-generation computer. 

 Second generation computers were based on Transistor instead of vacuum tubes. 

Few Examples are: Honeywell 400, IBM 7094,CDC 1604, CDC 3600, UNIVAC 1108 

Advantages:  

1. Due to the presence of transistors instead of vacuum tubes, the size of electron component 

decreased. This resulted in reducing the size of a computer as compared to first generation 

computers. 

2. Less energy and not produce as much heat as the first generation. 

3. Assembly language and punch cards were used for input. 

4. Low cost than first generation computers. 

5. Better speed, calculate data in microseconds. 

6. Better portability as compared to first generation 

 Disadvantages:  

1. A cooling system was required. 



 

2. Constant maintenance was required. 

3. Only used for specific purposes. 

Third Generation 

 1965-1971 is the period of third generation computer. 

 These computers were based on Integrated circuits. 

 IC was invented by Robert Noyce and Jack Kilby In 1958-1959. 

 IC was a single component containing number of transistors. 

Few Examples are PDP-8, PDP-11, ICL 2900, IBM 360, IBM 370 

Advantages:  

1. These computers were cheaper as compared to second-generation computers. 

2. They were fast and reliable. 

3. Use of IC in the computer provides the small size of the computer. 

4. IC not only reduce the size of the computer but it also improves the performance of the computer 

as compared to previous computers. 

5. This generation of computers has big storage capacity. 

6. Instead of punch cards, mouse and keyboard are used for input. 

7. They used an operating system for better resource management and used the concept of time-

sharing and multiple programming. 

8. These computers reduce the computational time from microseconds to nanoseconds. 

 Disadvantages:  

1. IC chips are difficult to maintain. 

2. The highly sophisticated technology required for the manufacturing of IC chips. 

3. Air conditioning is required. 

Fourth Generation 

 1971-1980 is the period of fourth generation computer. 

 This technology is based on Microprocessor. 

 A microprocessor is used in a computer for any logical and arithmetic function to be performed in 

any program. 

 Graphics User Interface (GUI) technology was exploited to offer more comfort to users.  

Few Examples are IBM 4341, DEC 10, STAR 1000, PUP 11 

Advantages:  

1. Fastest in computation and size get reduced as compared to the previous generation of 

computer. 

2. Heat generated is negligible. 

3. Small in size as compared to previous generation computers. 

4. Less maintenance is required. 

5. All types of high-level language can be used in this type of computers. 

Disadvantages:  

1. The Microprocessor design and fabrication are very complex. 

2. Air conditioning is required in many cases due to the presence of ICs. 

3. Advance technology is required to make the ICs. 

Fifth Generation 



 

 The period of the fifth generation in 1980-onwards. 

 This generation is based on artificial intelligence. 

 The aim of the fifth generation is to make a device which could respond to natural language 

input and are capable of learning and self-organization. 

 This generation is based on ULSI(Ultra Large Scale Integration) technology resulting in the 

production of microprocessor chips having ten million electronic component. 

Few Examples are Desktop, Laptop, NoteBook, UltraBook, Chromebook 

Advantages:  

1. It is more reliable and works faster. 

2. It is available in different sizes and unique features. 

3. It provides computers with more user-friendly interfaces with multimedia features. 

Disadvantages:  

1. They need very low-level languages. 

2. They may make the human brains dull and doomed. 

Computer - Input Devices 

Following are some of the important input devices which are used in a computer − 

 Keyboard 

 Mouse 

 Joy Stick 

 Light pen 

 Track Ball 

 Scanner 

 Graphic Tablet 

 Microphone 

 Magnetic Ink Card Reader(MICR) 

 Optical Character Reader(OCR) 

 Bar Code Reader 

 Optical Mark Reader(OMR) 

Keyboard 

Keyboard is the most common and very popular input device which helps to input data to the computer. 

The layout of the keyboard is like that of traditional typewriter, although there are some additional keys 

provided for performing additional functions. 



 

 

Keyboards are of two sizes 84 keys or 101/102 keys, but now keyboards with 104 keys or 108 keys are also 

available for Windows and Internet. 

The keys on the keyboard are as follows − 

S.No Keys & Description 

1 
Typing Keys 

These keys include the letter keys (A-Z) and digit keys (09) which generally give the same 

layout as that of typewriters. 

2 

Numeric Keypad 

It is used to enter the numeric data or cursor movement. Generally, it consists of a set of 17 

keys that are laid out in the same configuration used by most adding machines and 

calculators. 

3 

Function Keys 

The twelve function keys are present on the keyboard which are arranged in a row at the top 

of the keyboard. Each function key has a unique meaning and is used for some specific 

purpose. 

4 

Control keys 

These keys provide cursor and screen control. It includes four directional arrow keys. 

Control keys also include Home, End, Insert, Delete, Page Up, Page Down, Control(Ctrl), 

Alternate(Alt), Escape(Esc). 



 

5 

Special Purpose Keys 

Keyboard also contains some special purpose keys such as Enter, Shift, Caps Lock, Num 

Lock, Space bar, Tab, and Print Screen. 

Mouse 

Mouse is the most popular pointing device. It is a very famous cursor-control device having a small palm 

size box with a round ball at its base, which senses the movement of the mouse and sends corresponding 

signals to the CPU when the mouse buttons are pressed. 

Generally, it has two buttons called the left and the right button and a wheel is present between the buttons. 

A mouse can be used to control the position of the cursor on the screen, but it cannot be used to enter text 

into the computer. 

 

Advantages 

 Easy to use 

 Not very expensive 

 Moves the cursor faster than the arrow keys of the keyboard. 

Joystick 

Joystick is also a pointing device, which is used to move the cursor position on a monitor screen. It is a 

stick having a spherical ball at its both lower and upper ends. The lower spherical ball moves in a socket. 

The joystick can be moved in all four directions. 



 

 

The function of the joystick is similar to that of a mouse. It is mainly used in Computer Aided Designing 

(CAD) and playing computer games. 

Light Pen 

Light pen is a pointing device similar to a pen. It is used to select a displayed menu item or draw pictures on 

the monitor screen. It consists of a photocell and an optical system placed in a small tube. 

 

When the tip of a light pen is moved over the monitor screen and the pen button is pressed, its photocell 

sensing element detects the screen location and sends the corresponding signal to the CPU. 

Track Ball 

Track ball is an input device that is mostly used in notebook or laptop computer, instead of a mouse. This is 

a ball which is half inserted and by moving fingers on the ball, the pointer can be moved. 

 



 

Since the whole device is not moved, a track ball requires less space than a mouse. A track ball comes in 

various shapes like a ball, a button, or a square. 

Scanner 

Scanner is an input device, which works more like a photocopy machine. It is used when some information 

is available on paper and it is to be transferred to the hard disk of the computer for further manipulation. 

 

Scanner captures images from the source which are then converted into a digital form that can be stored on 

the disk. These images can be edited before they are printed. 

Digitizer 

Digitizer is an input device which converts analog information into digital form. Digitizer can convert a 

signal from the television or camera into a series of numbers that could be stored in a computer. They can 

be used by the computer to create a picture of whatever the camera had been pointed at. 

 

Digitizer is also known as Tablet or Graphics Tablet as it converts graphics and pictorial data into binary 

inputs. A graphic tablet as digitizer is used for fine works of drawing and image manipulation applications. 



 

Microphone 

Microphone is an input device to input sound that is then stored in a digital form. 

 

The microphone is used for various applications such as adding sound to a multimedia presentation or for 

mixing music. 

Magnetic Ink Card Reader (MICR) 

MICR input device is generally used in banks as there are large number of cheques to be processed every 

day. The bank's code number and cheque number are printed on the cheques with a special type of ink that 

contains particles of magnetic material that are machine readable. 

 

This reading process is called Magnetic Ink Character Recognition (MICR). The main advantages of MICR 

is that it is fast and less error prone. 

Optical Character Reader (OCR) 

OCR is an input device used to read a printed text. 



 

 

OCR scans the text optically, character by character, converts them into a machine readable code, and stores 

the text on the system memory. 

Bar Code Readers 

Bar Code Reader is a device used for reading bar coded data (data in the form of light and dark lines). Bar 

coded data is generally used in labelling goods, numbering the books, etc. It may be a handheld scanner or 

may be embedded in a stationary scanner. 

 

Bar Code Reader scans a bar code image, converts it into an alphanumeric value, which is then fed to the 

computer that the bar code reader is connected to. 

Optical Mark Reader (OMR) 

OMR is a special type of optical scanner used to recognize the type of mark made by pen or pencil. It is 

used where one out of a few alternatives is to be selected and marked. 



 

 

It is specially used for checking the answer sheets of examinations having multiple choice questions. 

Computer - Output Devices 

Following are some of the important output devices used in a computer. 

 Monitors 

 Graphic Plotter 

 Printer 

Monitors 

Monitors, commonly called as Visual Display Unit (VDU), are the main output device of a computer. It 

forms images from tiny dots, called pixels that are arranged in a rectangular form. The sharpness of the 

image depends upon the number of pixels. 

There are two kinds of viewing screen used for monitors. 

 Cathode-Ray Tube (CRT) 

 Flat-Panel Display 

Cathode-Ray Tube (CRT) Monitor 

The CRT display is made up of small picture elements called pixels. The smaller the pixels, the better the 

image clarity or resolution. It takes more than one illuminated pixel to form a whole character, such as the 

letter ‘e’ in the word help. 



 

 

A finite number of characters can be displayed on a screen at once. The screen can be divided into a series 

of character boxes - fixed location on the screen where a standard character can be placed. Most screens are 

capable of displaying 80 characters of data horizontally and 25 lines vertically. 

There are some disadvantages of CRT − 

 Large in Size 

 High power consumption 

Flat-Panel Display Monitor 

The flat-panel display refers to a class of video devices that have reduced volume, weight and power 

requirement in comparison to the CRT. You can hang them on walls or wear them on your wrists. Current 

uses of flat-panel displays include calculators, video games, monitors, laptop computer, and graphics 

display. 

 

The flat-panel display is divided into two categories − 

 Emissive Displays − Emissive displays are devices that convert electrical energy into light. For 

example, plasma panel and LED (Light-Emitting Diodes). 

 Non-Emissive Displays − Non-emissive displays use optical effects to convert sunlight or light from 

some other source into graphics patterns. For example, LCD (Liquid-Crystal Device). 



 

Printers 

Printer is an output device, which is used to print information on paper. 

There are two types of printers − 

 Impact Printers 

 Non-Impact Printers 

Impact Printers 

Impact printers print the characters by striking them on the ribbon, which is then pressed on the paper. 

Characteristics of Impact Printers are the following − 

 Very low consumable costs 

 Very noisy 

 Useful for bulk printing due to low cost 

 There is physical contact with the paper to produce an image 

These printers are of two types − 

 Character printers 

 Line printers 

Character Printers 

Character printers are the printers which print one character at a time. 

These are further divided into two types: 

 Dot Matrix Printer(DMP) 

 Daisy Wheel 

Dot Matrix Printer 

In the market, one of the most popular printers is Dot Matrix Printer. These printers are popular because of 

their ease of printing and economical price. Each character printed is in the form of pattern of dots and head 

consists of a Matrix of Pins of size (5*7, 7*9, 9*7 or 9*9) which come out to form a character which is why 

it is called Dot Matrix Printer. 



 

 

Advantages 

 Inexpensive 

 Widely Used 

 Other language characters can be printed 

Disadvantages 

 Slow Speed 

 Poor Quality 

Daisy Wheel 

Head is lying on a wheel and pins corresponding to characters are like petals of Daisy (flower) which is 

why it is called Daisy Wheel Printer. These printers are generally used for word-processing in offices that 

require a few letters to be sent here and there with very nice quality. 

 

 

Advantages 

 More reliable than DMP 

 Better quality 

 Fonts of character can be easily changed 



 

Disadvantages 

 Slower than DMP 

 Noisy 

 More expensive than DMP 

Line Printers 

Line printers are the printers which print one line at a time. 

 

These are of two types − 

 Drum Printer 

 Chain Printer 

Drum Printer 

This printer is like a drum in shape hence it is called drum printer. The surface of the drum is divided into a 

number of tracks. Total tracks are equal to the size of the paper, i.e. for a paper width of 132 characters, 

drum will have 132 tracks. A character set is embossed on the track. Different character sets available in the 

market are 48 character set, 64 and 96 characters set. One rotation of drum prints one line. Drum printers 

are fast in speed and can print 300 to 2000 lines per minute. 



 

 

Advantages 

 Very high speed 

Disadvantages 

 Very expensive 

 Characters fonts cannot be changed 

Chain Printer 

In this printer, a chain of character sets is used, hence it is called Chain Printer. A standard character set 

may have 48, 64, or 96 characters. 

 

 

Advantages 



 

 Character fonts can easily be changed. 

 Different languages can be used with the same printer. 

Disadvantages 

 Noisy 

Non-impact Printers 

Non-impact printers print the characters without using the ribbon. These printers print a complete page at a 

time, thus they are also called as Page Printers. 

These printers are of two types − 

 Laser Printers 

 Inkjet Printers 

Characteristics of Non-impact Printers 

 Faster than impact printers 

 They are not noisy 

 High quality 

 Supports many fonts and different character size 

Laser Printers 

These are non-impact page printers. They use laser lights to produce the dots needed to form the characters 

to be printed on a page. 

 

Advantages 

 Very high speed 



 

 Very high quality output 

 Good graphics quality 

 Supports many fonts and different character size 

Disadvantages 

 Expensive 

 Cannot be used to produce multiple copies of a document in a single printing 

Inkjet Printers 

Inkjet printers are non-impact character printers based on a relatively new technology. They print characters 

by spraying small drops of ink onto paper. Inkjet printers produce high quality output with presentable 

features. 

 

They make less noise because no hammering is done and these have many styles of printing modes 

available. Color printing is also possible. Some models of Inkjet printers can produce multiple copies of 

printing also. 

Advantages 

 High quality printing 

 More reliable 

Disadvantages 

 Expensive as the cost per page is high 

 Slow as compared to laser printer 

Computer - Memory 

A memory is just like a human brain. It is used to store data and instructions. Computer memory is the 

storage space in the computer, where data is to be processed and instructions required for processing are 



 

stored. The memory is divided into large number of small parts called cells. Each location or cell has a 

unique address, which varies from zero to memory size minus one. For example, if the computer has 64k 

words, then this memory unit has 64 * 1024 = 65536 memory locations. The address of these locations 

varies from 0 to 65535. 

Memory is primarily of three types − 

 Cache Memory 

 Primary Memory/Main Memory 

 Secondary Memory 

Cache Memory 

Cache memory is a very high speed semiconductor memory which can speed up the CPU. It acts as a buffer 

between the CPU and the main memory. It is used to hold those parts of data and program which are most 

frequently used by the CPU. The parts of data and programs are transferred from the disk to cache memory 

by the operating system, from where the CPU can access them. 

 

Advantages 

The advantages of cache memory are as follows − 

 Cache memory is faster than main memory. 

 It consumes less access time as compared to main memory. 

 It stores the program that can be executed within a short period of time. 

 It stores data for temporary use. 

Disadvantages 

The disadvantages of cache memory are as follows − 



 

 Cache memory has limited capacity. 

 It is very expensive. 

Primary Memory (Main Memory) 

Primary memory holds only those data and instructions on which the computer is currently working. It has a 

limited capacity and data is lost when power is switched off. It is generally made up of semiconductor 

device. These memories are not as fast as registers. The data and instruction required to be processed 

resides in the main memory. It is divided into two subcategories RAM and ROM. 

 

Characteristics of Main Memory 

 These are semiconductor memories. 

 It is known as the main memory. 

 Usually volatile memory. 

 Data is lost in case power is switched off. 

 It is the working memory of the computer. 

 Faster than secondary memories. 

 A computer cannot run without the primary memory. 

Secondary Memory 

This type of memory is also known as external memory or non-volatile. It is slower than the main memory. 

These are used for storing data/information permanently. CPU directly does not access these memories, 

instead they are accessed via input-output routines. The contents of secondary memories are first transferred 

to the main memory, and then the CPU can access it. For example, disk, CD-ROM, DVD, etc. 



 

 

Characteristics of Secondary Memory 

 These are magnetic and optical memories. 

 It is known as the backup memory. 

 It is a non-volatile memory. 

 Data is permanently stored even if power is switched off. 

 It is used for storage of data in a computer. 

 Computer may run without the secondary memory. 

 Slower than primary memories. 

Random Access Memory 

RAM (Random Access Memory) is the internal memory of the CPU for storing data, program, and program 

result. It is a read/write memory which stores data until the machine is working. As soon as the machine is 

switched off, data is erased. 

 

Access time in RAM is independent of the address, that is, each storage location inside the memory is as 

easy to reach as other locations and takes the same amount of time. Data in the RAM can be accessed 

randomly but it is very expensive. 



 

RAM is volatile, i.e. data stored in it is lost when we switch off the computer or if there is a power failure. 

Hence, a backup Uninterruptible Power System (UPS) is often used with computers. RAM is small, both in 

terms of its physical size and in the amount of data it can hold. 

RAM is of two types − 

 Static RAM (SRAM) 

 Dynamic RAM (DRAM) 

Static RAM (SRAM) 

The word static indicates that the memory retains its contents as long as power is being supplied. However, 

data is lost when the power gets down due to volatile nature. SRAM chips use a matrix of 6-transistors and 

no capacitors. Transistors do not require power to prevent leakage, so SRAM need not be refreshed on a 

regular basis. 

There is extra space in the matrix, hence SRAM uses more chips than DRAM for the same amount of 

storage space, making the manufacturing costs higher. SRAM is thus used as cache memory and has very 

fast access. 

Characteristic of Static RAM 

 Long life 

 No need to refresh 

 Faster 

 Used as cache memory 

 Large size 

 Expensive 

 High power consumption 

Dynamic RAM (DRAM) 

DRAM, unlike SRAM, must be continually refreshed in order to maintain the data. This is done by placing 

the memory on a refresh circuit that rewrites the data several hundred times per second. DRAM is used for 

most system memory as it is cheap and small. All DRAMs are made up of memory cells, which are 

composed of one capacitor and one transistor. 

Characteristics of Dynamic RAM 

 Short data lifetime 

 Needs to be refreshed continuously 

 Slower as compared to SRAM 

 Used as RAM 

 Smaller in size 



 

 Less expensive 

 Less power consumption 

Computer - Read Only Memory 

ROM stands for Read Only Memory. The memory from which we can only read but cannot write on it. 

This type of memory is non-volatile. The information is stored permanently in such memories during 

manufacture. A ROM stores such instructions that are required to start a computer. This operation is 

referred to as bootstrap. ROM chips are not only used in the computer but also in other electronic items 

like washing machine and microwave oven. 

 

Let us now discuss the various types of ROMs and their characteristics. 

MROM (Masked ROM) 

The very first ROMs were hard-wired devices that contained a pre-programmed set of data or instructions. 

These kind of ROMs are known as masked ROMs, which are inexpensive. 

PROM (Programmable Read Only Memory) 

PROM is read-only memory that can be modified only once by a user. The user buys a blank PROM and 

enters the desired contents using a PROM program. Inside the PROM chip, there are small fuses which are 

burnt open during programming. It can be programmed only once and is not erasable. 

EPROM (Erasable and Programmable Read Only Memory) 

EPROM can be erased by exposing it to ultra-violet light for a duration of up to 40 minutes. Usually, an 

EPROM eraser achieves this function. During programming, an electrical charge is trapped in an insulated 

gate region. The charge is retained for more than 10 years because the charge has no leakage path. For 

erasing this charge, ultra-violet light is passed through a quartz crystal window (lid). This exposure to ultra-

violet light dissipates the charge. During normal use, the quartz lid is sealed with a sticker. 

EEPROM (Electrically Erasable and Programmable Read Only Memory) 

EEPROM is programmed and erased electrically. It can be erased and reprogrammed about ten thousand 

times. Both erasing and programming take about 4 to 10 ms (millisecond). In EEPROM, any location can 



 

be selectively erased and programmed. EEPROMs can be erased one byte at a time, rather than erasing the 

entire chip. Hence, the process of reprogramming is flexible but slow. 

Advantages of ROM 

The advantages of ROM are as follows − 

 Non-volatile in nature 

 Cannot be accidentally changed 

 Cheaper than RAMs 

 Easy to test 

 More reliable than RAMs 

 Static and do not require refreshing 

 Contents are always known and can be verified 

Computer - Hardware 

Hardware represents the physical and tangible components of a computer, i.e. the components that can be 

seen and touched. 

Examples of Hardware are the following − 

 Input devices − keyboard, mouse, etc. 

 Output devices − printer, monitor, etc. 

 Secondary storage devices − Hard disk, CD, DVD, etc. 

 Internal components − CPU, motherboard, RAM, etc. 

Computer - Software 

Software is a set of programs, which is designed to perform a well-defined function. A program is a 

sequence of instructions written to solve a particular problem. 

There are two types of software − 

 System Software 

 Application Software 

System Software 

The system software is a collection of programs designed to operate, control, and extend the processing 

capabilities of the computer itself. System software is generally prepared by the computer manufacturers. 

These software products comprise of programs written in low-level languages, which interact with the 

hardware at a very basic level. System software serves as the interface between the hardware and the end 

users. 

Some examples of system software are Operating System, Compilers, Interpreter, Assemblers, etc. 



 

 

Here is a list of some of the most prominent features of a system software − 

 Close to the system 

 Fast in speed 

 Difficult to design 

 Difficult to understand 

 Less interactive 

 Smaller in size 

 Difficult to manipulate 

 Generally written in low-level language 

Application Software 

Application software products are designed to satisfy a particular need of a particular environment. All 

software applications prepared in the computer lab can come under the category of Application software. 

Application software may consist of a single program, such as Microsoft's notepad for writing and editing a 

simple text. It may also consist of a collection of programs, often called a software package, which work 

together to accomplish a task, such as a spreadsheet package. 

Examples of Application software are the following − 

 Payroll Software 

 Student Record Software 

 Inventory Management Software 

 Income Tax Software 

 Railways Reservation Software 

 Microsoft Office Suite Software 

 Microsoft Word 

 Microsoft Excel 

 Microsoft PowerPoint 



 

 

Features of application software are as follows − 

 Close to the user 

 Easy to design 

 More interactive 

 Slow in speed 

 Generally written in high-level language 

 Easy to understand 

 Easy to manipulate and use 

 Bigger in size and requires large storage space 

 

Operating System 

 



 

As the name suggests, an operating system is a type of software without which you cannot operate or run a 

computer. It acts as an intermediary or translation system between computer hardware and application 

programs installed on the computer. In other words, you cannot directly use computer programs with 

computer hardware without having a medium to establish a connection between them. 

Besides this, it is also an intermediary between the computer user and the computer hardware as it provides a 

standard user interface that you see on your computer screen after you switch on your computer. For 

example, the Windows and the Mac OS are also operating systems that provide a graphical interface with 

icons and pictures to enable users to access multiple files and applications simultaneously. 

So, although the operating system is itself a program or software, it allows users to run other programs or 

applications on the system. We can say that is works behind the scenes to run your computer. 

Major Functions of Operating System: 

o Memory management: It manages both the primary and secondary memory such as RAM, ROM, 

hard disk, pen drive, etc. It checks and decides the allocations and deallocation of memory space to 

different processes. When a user interacts with a system, the CPU is supposed to read or write 

operations, in this case, OS decides the amount of memory to be allocated for loading the program 

instructions and data into RAM. After this program is terminated, the memory area is again free and 

is ready to be allocated to other programs by the OS. 

o Processor Management: It facilitates processor management, where it decides the order for the 

processes to access the processor as well as decides the processing time to be allocated for each 

process. Besides this, it monitors the status of processes, frees the processor when a process is 

executed then allocates it to a new process. 

o Device/ hardware management: The operating system also contains drivers to manage devices. A 

driver is a type of translation software that allows the operating system to communicate with devices, 

and there are different drivers for different devices as each device speaks a different language. 

o Run software applications: It offers the environment to run or use software applications developed 

to perform specific tasks, for example, Ms Word, Ms Excel, Photoshop, etc. 

o Data management: It helps in data management by offering and displaying directories for data 

management. You can view and manipulate files, folders, e.g., you can move, copy, name, or rename, 

delete a file or a folder. 

o Evaluates the system's health: It gives us an idea about the performance of the hardware of the 

system. For example, you can see how busy the CPU is, how fast the data is retrieved from the hard 

disk, etc. 

o Provides user interface: It acts as an interface between the user and the hardware. It can be a GUI 

where you can see and click elements on the screen to perform various tasks. It enables you to 

communicate with the computer even without knowing the computer's language. 

o I/O management: It manages the input output devices and makes the I/O process smooth and 

effective. For example, it receives the input provided by the user through an input device and stores it 
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in the main memory. Then it directs the CPU to process this input and accordingly provides the 

output through an output device such as a monitor. 

o Security: It has a security module to protect the data or information stored in the memories of the 

computer against malware and unauthorized access. Thus, it not only manages your data but also 

helps to protect it. 

o Time Management: It helps CPU in time management. The Kernel OS keeps checking the 

frequency of processes that requests CPU time. When two or more processes that are equally 

important compete for the CPU time, then the CPU time is sliced into segments and allocated to these 

processes in a round-robin fashion to prevent a single process from monopolizing the CPU. 

o Deadlock Prevention: Sometimes a resource that is supposed to be shared by two or more processes 

is held by one process due to which the resource cannot continue. This situation is known as 

deadlock. The OS does not let this situation arise by carefully distributing the resources among the 

different processes. 

o Interrupt Handling: OS also responds to interrupts, which are signals generated by a program or a 

device to seek the attention of the CPU. The OS checks the priority of the interrupt, and if it is more 

important than the currently running process, it stops the execution of the current process and 

preserves this state of CPU then executes the requested process. Thereafter the CPU returns to the 

same state where it was stopped. 

Types of Operating System: 

1) Batch Processing Operating System: 

 

The interaction between a user and the computer does not occur in this system. The user is required to 

prepare jobs on punch cards in the form of batches and submit them to the computer operator. The computer 

operator sorts the jobs or programs and keeps similar programs or jobs in the same batch and run as a group 



 

to speed up processing. It is designed to execute one job at a time. Jobs are processed on a first-come, first-

serve basis, i.e., in the order of their submission without any human intervention. 

For example, the credit card bill generated by banks is an example of batch processing. A separate bill is not 

generated for each credit card purchase, rather a single bill that includes all purchases in a month is 

generated through batch processing. The bill details are collected and held as a batch, and then it is processed 

to generate the bill at the end of the billing cycle. Similarly, in a payroll system, the salaries of employees of 

the company are calculated and generated through the batch processing system at the end of each month. 

Advantages of Batch processing operating system: 

o Repeated jobs can be completed easily without any human intervention 

o Hardware or system support is not required to input data in batch systems 

o It can work offline, so it causes less stress on the processor as it knows which task to process next 

and how long the task will last. 

o It can be shared among multiple users. 

o You can set the timing of batch jobs so that when the computer is not busy, it can start processing the 

batch jobs such as at night or any other free time. 

Disadvantages of batch processing operating systems: 

o You need to train the computer operators for using the batch system. 

o It is not easy to debug this system. 

o If any error occurs in one job, the other jobs may have to wait for an uncertain time. 

2) Time Sharing Operating System: 



 

 

As the name suggests, it enables multiple users located at different terminals to use a computer system and to 

share the processor's time simultaneously. In other words, each task gets time to get executed, and thus all 

tasks are executed smoothly. 

Each user gets the processor's time as they get while using a single system. The duration of time allocated to 

a task is called quantum or time slice; when this duration is over, OS starts the next task. 

Advantages of time sharing operating system: 

o It reduces CPU idle time and thus makes it more productive. 

o Each process gets the chance to use the CPU. 

o It allowed different applications run simultaneously. 

Disadvantages of time sharing operating system: 

o It requires a special operating system as it consumes more resources. 

o Switching between tasks may hang up the system as it serves lots of users and runs lots of 

applications at the same time, so it requires hardware with high specifications. 

o It is less reliable. 

3) Distributed Operating System: 



 

 

It uses or runs on multiple independent processors (CPUs) to serve multiple users and multiple real-time 

applications. The communication between processors is established through many communication lines such 

as telephone lines and high-speed buses. The processors may differ from each other in terms of size and 

function. 

The availability of powerful microprocessor and advanced communication technology have made it possible 

to design, develop, and use the distributed operating system. Besides this, it is an extension of a network 

operating system that supports a high level of communication and integration of machines on the network. 

Advantages of distributed operating system: 

o Its performance is higher than a single system as resources are being shared. 

o If one system stops working, malfunctions, or breaks down, other nodes are not affected. 

o Additional resources can be added easily. 

o Shared access to resources like printer can be established. 

o Delay in processing is reduced to a greater extent. 

o Data sharing or exchange speed is high, owing to the use of electronic mail. 

Disadvantages of distributed operating system: 

o Security issue may arise due to sharing of resources 

o Few messages may be lost in the system 

o Higher bandwidth is required in case of handling a large amount of data 

o Overloading issue may arise 
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o The performance may be low 

o The languages which are used to set up a distributed system are not well defined yet 

o They are very costly, so they are not easily available. 

4)Network Operating System: 

 

As the name suggests, this OS connects computers and devices to a local area network and manages network 

resources. The software in a NOS enables the devices of the network to share resources and communicate 

with each other. It runs on a server and allows shared access to printers, files, applications, files, and other 

networking resources and functions over a LAN. Besides this, all users in the network are aware of each 

other's underlying configuration and individual connections. Examples: Ms Windows Server 2003 and 

2008, Linux, UNIX, Novell NetWare, Mac OS X, etc. 

Advantages of network operating system: 

o The servers are centralized that can be accessed remotely from distant locations and different 

systems. 

o It is easy to integrate advanced and recent technologies and hardware in this system. 

Disadvantages of network operating system: 
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o The servers used in the system may be expensive. 

o The system depends on the central location and requires regular monitoring and maintenance. 

5) Real-Time Operating System: 

 

It is developed for real-time applications where data should be processed in a fixed, small duration of time. It 

is used in an environment where multiple processes are supposed to be accepted and processed in a short 

time. RTOS requires quick input and immediate response, e.g., in a petroleum refinery, if the temperate gets 

too high and crosses the threshold value, there should be an immediate response to this situation to avoid the 

explosion. Similarly, this system is used to control scientific instruments, missile launch systems, traffic 

lights control systems, air traffic control systems, etc. 

This system is further divided into two types based on the time constraints: 

Hard Real-Time Systems: 

These are used for the applications where timing is critical or response time is a major factor; even a delay of 

a fraction of the second can result in a disaster. For example, airbags and automatic parachutes that open 

instantly in case of an accident. Besides this, these systems lack virtual memory. 

Soft Real-Time Systems: 



 

These are used for application where timing or response time is less critical. Here, the failure to meet the 

deadline may result in a degraded performance instead of a disaster. For example, video surveillance (cctv), 

video player, virtual reality, etc. Here, the deadlines are not critical for every task every time. 

Advantages of real-time operating system: 

o The output is more and quick owing to the maximum utilization of devices and system 

o Task shifting is very quick, e.g., 3 microseconds, due to which it seems that several tasks are 

executed simultaneously 

o Gives more importance to the currently running applications than the queued application 

o It can be used in embedded systems like in transport and others. 

o It is free of errors. 

o Memory is allocated appropriately. 

Disadvantages of real-time operating system: 

o A fewer number of tasks can run simultaneously to avoid errors. 

o It is not easy for a designer to write complex and difficult algorithms or proficient programs required 

to get the desired output. 

o Specific drivers and interrupt signals are required to respond to interrupts quickly. 

o It may be very expensive due to the involvement of the resources required to work. 

 

 

UNIT - 2 
 

Introduction to Microsoft Word 
Microsoft word is a word processor software developed by Microsoft in 1983. It is the most 

commonly used word processor software. It is used to create professional quality documents, letters, 

reports, resumes, etc and also allows you to edit or modify your new or existing document. The file 

saved in Ms Word has .docx extension.  

 

How to open MS Word? 
Step 1: Type Ms Word in the search bar. 

 

 

 



 

 

Step 2: Select Ms Word application. 

 

Create a blank document 

1. Open Word. Or, if Word is already open, select File > New. 

2. Select Blank document. 

Create a document using a template 

1. Open Word. Or, if Word is already open, select File > New. 



 

 

2. Double-click a template to open it. 

Tip: Pin templates you like, so you always see them when you start Word. Select the template and then select the 

pin icon that appears next to the name of the template. 

Search for a template 

1. Open Word. Or, if Word is already open, select File > New. 

2. In the Search for online templates box, enter a search word 

like letter, resume, or invoice. 

 



 

Or, select a category under the search box 

like Business, Personal, or Education. 

3. Click a template to see a preview. Click the arrows on the side 

of the preview to see more templates. 

 

4. Select Create. 

Step-by-Step: Letter Wizard   

 

What you will 
learn: 

to use a wizard to create a new document 

 

Select Wizard 

1. From the menu choose  File  |  New . 
  The New dialog opens. 
 The New Document task pane opens. 
  



 

2.   Click on the tab for Letters & Faxes.   

Click on  the link for General Templates, and then on the tab for 
Letters & Faxes. 

   Click on  the link for On my computer...., and then on the tab for 
Letters & Faxes. 

 

  The New dialog 

 

  The Template dialog 

What tabs and templates you see depends on which templates and wizards are 
installed. You can create your own groupings by adding folders to the Templates 
folder on your hard drive. [The Letter Wizard in Word 95 includes the same 
choices, but produces a very different letter.] 
  

3. Select the Letter Wizard.wiz and then click OK. The Letter Wizard begins. 



 

A partial letter appears, using the defaults to fill in the parts with gray 
background. Recall that the gray background indicates that there is a field here, 
for information that might change. The gray does not print. 

The Office Assistant asks if you want to send one letter or to use a mailing list. 
box. 

 
 

If Office Assistant is turned off, you will see a 
normal dialog 

 

 

4. Select Send one letter and click on OK. The first step in the Letter Wizard 
appears. 

 

Wizard Step 1: Letter Format   



 

1. Look at all the choices. 
  

2. Make these your final choices: 

Date line: month day, year. 
Page design: Elegant Letter 
Letter style: Full block. 
Pre-printed letterhead box 
= unchecked. 
  

3. Click on the Next button to continue. 

 

 

 

Wizard Step 2: Recipient Info 

This tab is for in the information about the recipient (the person to whom you are 
writing). 
  

1. Type the following information - 
  
Recipient's name: 
   Luis Perez 

Delivery address:  
  World Travel, Inc.  
  Montevideo 6553 
  Buenos Aires 1123 Argentina 
  

2. Select each Salutation style in turn to see 
the differences. Choose the Business style 
for the Salutation.  
  

3. Click on the Next button to continue.  
  



 

 
 

 

Wizard Step 3: Other Elements 

This tab is a collection of miscellaneous elements. 

1. Enter the information for a copy in the CC 
box: 
 Tom Johnson, President 
  AAA Sales 
    

2. Click on the Next button to continue. 

 

 

 

Wizard Step 4: Sender Info 

This tab is for information about YOU - the sender of the letter. Some information will 
be already filled in if someone has filled in the dialog at  Tools  |  Options  |  User Information . 
You are going to play the role of Sandra Green for 
this letter. 

1.  Fill in the information about Ms. Green - 
Sender's name: 
  Sandra Green 
Return address: 
142 South Main Street 
Nashville TN 48559 
USA 
  

2. Make the following selections, or type the 
information in the blank- 
Complimentary closing: Sincerely, 
Job title: Sales Manager 
Company: AAA Sales 
Writer/typist initials: SG 



 

Enclosures: unchecked 
  

3. Click on Finish. 
Your letter opens, now using the information you gave the wizard. It has 
temporary text for you to replace with your own for the letter's body.  
 

 

4. The Office Assistant may ask if you want to do some more with the letter, like 
make an envelope or label. Click on Cancel this time. 

You can rerun the wizard later, if you need to, from the  Tools  menu. You will 
have to click on each tab yourself. (Can you manage such a hard task!?) 
  

5. Scroll to the bottom of the page. Surprise! The wizard 
put your return address down here! A kind of letterhead 
on the bottom. 
  

6.  Save as  letter-AAA.doc  in the  word project2  folder of your Class disk. 

 

 



 

 



 

6. Click OK. 



 

 



 

 

 



 

 



 

Printing Documents 
The following steps will help you print your Microsoft Word document. 

Step 1 − Open the document for which you want to see the preview. Next click 

the File tab followed by the Print option which will display a preview of the 

document in the right column. You can scroll up or scroll down your document to 

walk through the document using given Scrollbar. The middle column gives various 

options to be set before you send your document to the printer. 

 

Step 2 − You can set various other printing options available. Select from among the 

following options, depending on your preferences. 

 

S.No Option and Description 

1 

Copies 

Set the number of copies to be printed; by default, you will have one copy 

of the document. 



 

2 

Print Custom Range 

This option will be used to print a particular page of the document. Type 

the number in Pages option, if you want to print all the pages from 7 till 

10 then you would have to specify this option as 7-10 and Word will print 

only 7th, 8th, 9th and 10th pages. 

3 

Print One Sided 

By default, you print one side of the page. There is one more option where 

you will turn up your page manually in case you want to print your page 

on both sides of the page. 

4 

Collated 

By default, multiple copies will print Collated; if you are printing multiple 

copies and you want the copies uncollated, select the Uncollated option. 

5 

Orientation 

By default, page orientation is set to Portrait; if you are printing your 

document in landscape mode then select the Landscape mode. 

6 

A4 

By default, the page size is A4, but you can select other page sizes 

available in the dropdown list. 

7 

Custom Margin 

Click the Custom Margins dropdown list to choose the document margins 

you want to use. For instance, if you want to print fewer pages, you can 

create narrower margins; to print with more white space, create wider 

margins. 

8 

1 Page Per Sheet 

By default, the number of pages per sheet is 1 but you can print multiple 

pages on a single sheet. Select any option you like from the given 

dropdown list by clicking over the 1 Page Per Sheet option. 



 

Step 3 − Once you are done with your setting, click on the Print button which will 

send your document to the printer for final printing. 

 

 



 

Editing Word document 

Cut , Copy and Paste options 

 

These options will allow you to Cut or Copy a piece of text from one location and to paste at 

a new location. 

 

Place the cursor at the begining of the text to be selected. Drag the mouse pointer over the 

text.  

 

Click Edit menu and then click on Cut option (or) click  icon on the Standard Toolbar. 

Move the cursor to the place where you want the text to be pasted. 

 

Click Edit menu and then click Paste option (or) click      icon on the Standard Toolbar. 

 

For copying the text from one location to other location the same procedure is to be followed. 

The difference between Cut and Copy is that while using the Cut option the text will be 

removed from its original location and pasted at a new location, where as when using Copy 

option a copy of the selected text is pasted at new location without disturbing the original text. 

Searching text 

 

Open any document. 

Click Edit menu and then click Find option. You will get a screen as shown below. 

 

 

 

In Find What text box type the word you want to find and then click Find Next button. 

Continue clicking Find Next button until you get the screen shown below. 



 

 
 

Click OK button and then click X to close Find and Replace dialog box. 

 

Replacing text 

 

Open any word document. 

Click Edit menu and then click Replace option. You will get the dialog box as 

shown below and type the word with which you want to replace. 

 
 

 

Click ReplaceAll button once. You get the below dialog box. 

 

 

 

Click OK button and then click X to close Find and Replace dialog box. 

 

 



 

 

 

Formatting documents 

Bold, Underline and Italicize the selected text Open a word document.  

Block the text by first clicking at the start of the text and holding the left mouse button and drag 

to the desired position and then release the left mouse button. The selected area will be 

highlighted. Move the mouse pointer to the button  on the Standard Toolbar and click 

once. Move the mouse pointer outside your text and click to release the highlighting. Your 

text will now appear in BOLD FACE.Like this you can underline or italicize the desired text 

by using the following buttons  

    Left aligning, centering , right aligning and justifying text 

 

Left Centre Right Justify 

 

Open a word document. 

Block the text by first clicking at the start of the text and holding the left mouse button and drag to 

the desired position and then release the left mouse button. The selected area will be highlighted. 

Move the mouse pointer to Align Left button on the toolbar and click once. Your selected text 

will be left aligned. 

Move the mouse pointer to Align right button on the toolbar and click once. Your selected text will 

be right aligned. 

Move the mouse pointer to Center button on the toolbar and click once. Your selected text will be 

centered. 

Move the mouse pointer to Justify button on the toolbar and click once. Your selected text will be 

justified. 

 

Creating Bulleted and Numbered list 

 

If a list of items are to be numbered automatically it can be done using 

Numbered List option 

 

Ex: Microsoft Office consists 

of MS-Word MS-Excel MS-PowerPoint MS- Access MS-Outlook 

 

The above text is to be selected with mouse. 

Click on the Numbered List button on the toolbar  



 

Move out of the text and click to release the highlighting. Your 

text will now look like this 

 

1. MS-Word 

2. MS-Excel 

3. MS-PowerPoint 

4. MS-Access 

5. MS-Outlook 

 

Now re-select the text 

Click the Bulleted List button on the toolbar. 

 

The numbers should be replaced with bullets as shown below 

 

· MS-Word 

· MS-Excel 

· MS-PowerPoint 

· MS-Access 

· MS-Outlook 

 

Indenting Paragraphs 

 

Select a paragraph with the mouse. 

Click on the Right (increase) Indent toolbar.

 

 

 

button on the 



 

       Leave the highlighting on and click once more on the Right Indent button. 

Click once on the Left Indent  button. Your text should now be indented by one Tab stop. Each 

time you click, the paragraph is moved one tab stop. 

 

Changing case of text 

 

You can change the selected text into either UPPERCASE, lowercase, Title case or tOGGLE 

cASE Highlight the text. Select the Format menu option 

Choose Change Case option. You will get the dialog box shown below. 

 

 

 

From the list of options select UPPERCASE to convert lower case into 

uppercase 

 

Font Controlling 

 

To get different character styles we can change Font type Click on 

Format menu 

Select Font option. You will get the following screen. 

b 



 

 
 

 

You can set Font type, Font Style and Font size and Color of the selected 

text. 

Click OK button. 

 

Note: The above options are also available on the Formatting Toolbar 

 

Font style Font Type Font size Color 

 

Creating column wise documents Open any 

word document file. 

Click Format menu and click Columns option. You will get a screen as shown 

below: 



 

 
 

In the Presets tab, select Two option to get below screen. 

 

 

 

Click OK button. 

Your document will be converted to two-column document. 



 

Spelling and Grammar Checking of word document 

 

Open any word document. 

Click Tools menu and then click Spelling and Grammar option. You will get 

the below dialog box. 

 

 

 

Note all words that appear red color in First box are spelling mistakes. If you want 

to accept the suggested word, in the second box click on Change. If not, click 

Ignore button. You can also add a word to the dictionary by clicking on the Add 

button. 

Continue this process until you get the dialog box, shown below: 

 

Click OK button. 

Save your work when the spell-check is complete, so that the corrections are 

saved. 



 

Printing document 

Set Page Setup options Click 

File menu 

Select and click Page Setup option. You will get the following screen. 

 

 

 

Here you can set margins (top, bottom, right and left), paper size, paper source 

and layout. 

Click OK button. 

 

Creating Header and footer 

 

You can create header and footer that include text or graphics. For example, 

page numbers, the date, a company logo, the document’s title or file name, the 

author’s name, and so on. You can use the same header and footer throughout a 

document or change the header and footer for part of the 



 

document. For example, use a unique header or footer on the first page, or leave 

the header or footer off the first page. You can also use different headers and 

footers on odd and even pages or for part of a document. 

 

The Header and Footer tool bar is 

 

 

To Create header or footer 

 

 

Creating different footers or headers for even and odd pages 



 

 

 
 

Preview document 

 

Open any word document. 

Click File menu and then click Print Preview option. You will get a screen 

similar to this. 

 



 

You won’t be able to read your text, as preview is just for checking the layout. 

If you move the mouse pointer into the page a tiny magnifying glass icon 

appears. If you click on this, it magnifies the selected page. 

 

Press PgDn to move through your document if it is more than one page long. 

 

 

If you need to make changes before printing, click the Close button to return to 

your document 

 

Inserting pictures into the document  

Inserting Clip arts 

Click Insert menu, click picture and then click Clip Art. You will get screen as 

shown below 

 
 

 

Select the picture and then click Insert button. The selected picture will be inserted 

at the cursor position. 

 

 

 



 

Auto correct 

 

AutoCorrect stores a list of common typographical errors and their spellings. 

When you make an error, Word detects it and inserts the correctly spelled version 

of the word. You can add words to the AutoCorrect list, based on the mistakes you 

make. Look at the AutoCorrect dialog box. 

 

Note that tm within parenthesis is automatically replaced by ™ with trademark symbol. To 

Add an AutoCorrect 

 

Click Tools then click AutoCorrect, type the word in the place provided for Replace and 

With Options then click Add and then click OK. You can Delete an AutoCorrect option if 

you don't want it. 

 

AutoFormat 

 

Use AutoFormat to reformat an entire document using a selected document 

template as a basis for the changes. Templates are supplied with Word, or you can 

create your own templates based on a document in which styles are applied to text, 

headings, lists and other text and graphic elements within the document. You can use 

Format/Style Gallery to view and apply available style templates to your document. 

Autoformat applies a style to every paragraph and heading. It typically replaces 

indentations created with spaces or tabs with paragraph indents, asterisks and dashes 

with bullets, and so on. 

 

Auto Text 



 

 

The AutoText feature lets you store commonly used passages, such as addresses, contract 

clauses, etc., and insert them whenever needed with a click of your mouse to create an 

AutoText entry. 

             Select a graphic or text block such as your name and address in your document. 

Pick the Insert / AutoText menu selection: The Auto Text dialog box is displayed as 

shown below 

 
 

Type a Short name in the Name box and click Add. 

To use Stored Auto Text 

 

Type the short name of your Auto text and Highlight it. 

Click Insert/ AutoText from menu and then click Insert . The text is inserted in 

place of the selected AutoText name. 

 

To remove an AutoText item: 

 

Pick Insert/AutoText to get the AutoText dialog box. Pick an 

AutoText name and click Delete and Close 



 

Password Protecting the document 

 

Open any word document. 

Click Tools menu and then click Options Click Security tab. You will get 

screen as shown below. 

 

 

In the Password to open text box, type your password (Ex: type mahesh). Your 

password will appear as group of ***. Click OK button. You will get the 

following screen. 

 
Reenter the same password and then click OK button. 



 

Close the document by clicking File and then clicking Close option. 

Open the same document by clicking File and then clicking Open option. 

You will get a screen as shown below. 

 

If you type the same password as earlier (mahesh) then only you can open the 

file. 

Enter the password and then click OK button. 

If you want to delete the password click Tools menu and then click Options. 

Delete the password in the Password to open text box. Click OK button. 

Your document will be unprotected. 

 

Thesaurus 

The tools /Thesaurus menu selection gives you possible meanings and synonyms 

for selected words in your documents. This helps you be more precise in your 

writing. To use the Thesaurus, position the cursor in front of a word or highlight 

it. And Right Click and Then you will find a dropdown menu and select 

synonyms option select Thesaurus menu as shown below . 

 



 

 

 

Lists of possible meanings and synonyms are displayed. Pick a desired word so 

that it is in the Replace with Synonym box and click the Replace button to use it. 

Use the Look Up button to find alternate meanings of a selected word in the 

Meanings box. Click Cancel to exit the Thesaurus dialog box without accepting 

any of the suggested changes. 

 

UNIT - 3  MS  EXCEL 

A spreadsheet is essentially a matrix of rows and columns. Consider a sheet of 

paper on which horizontal and vertical lines are drawn to yield a rectangular grid. The 

grid namely a cell, is the result of the intersection of a row with a column. Such a 

structure is called a Spreadsheet. 

 

A spreadsheet package contains electronic equivalent of a pen, an eraser and large 

sheet of paper with vertical and horizontal lines to give rows and columns. The cursor 

position uniquely shown in dark mode indicates where the pen is currently pointing. We 

can enter text or numbers at any position on the worksheet. We can enter a formula in a 

cell where we want to perform a calculation and results are to be displayed. A powerful 

recalculation facility jumps into action each time we update the cell contents with new 

data. 

MS-Excel is the most powerful spreadsheet package brought by Microsoft. The 

three main components of this package are 

 

 

Starting Excel 2003 

 

Switch on your computer and click on the Start button at the bottom left of the 

screen. 

 

Move the mouse pointer to Programs, then across to Microsoft Excel, then 

click on Excel as shown in this screen. 



 

 

 

 

 

 

 
 

 

When you open Excel a screen similar to this will appear 



 

 

 
 

 

The options shown below is called as Menu Bar 

 

 

The collection of icons for common operations shown below is called as 

Standard Tool Bar 



 

 



 

 
 

 

The formula bar is the place in which you enter the formula(=A3*B5) 

 

 

 

 

The alphabets A,B… are known as columns 



 

 
 

This is the name of the workbook. (Book1) 

 

 

The rows are numbered as 1,2,3… 

 

Sheet1,Sheet2, Sheet3 are known as worksheet tabs 

 

 

 

 

Task 1: Creating a new workbook 

 

Click on File menu and then click on New. 



 

 

 

Click Workbook and then click OK button. You will get the screen as shown 

below. 



 

 

 
 

Enter data as shown in the figure below : 

 



 

 

Task 2: Saving Workbook 

 

Click on File menu and then click save. You will get the below screen 

 

 

In the File name text box, type sample and then click Save button 

 

Task 3: Opening an existing workbook 

 

Click on the File menu and click on Open. The open dialog box will appear 



 

 
 

Click on some file (Example: sample.xls), then click on Open. 

 

Task 4: Closing your workbook 

 

 

 

 

. 

 
 



 

Save your work by clicking File and then Save As. This dialog box appears. 

 

 

Type cash in the File Name text box and then click Save button. Excel 

automatically adds the extension .xls to your file name. 



 

 

Task 2: Editing data 

 

Click File and then click Open. Click 

cash.xls and then click Open. 

Move the mouse pointer to cell D4, click and release. The cell is highlighted and 

18 appears in the formula bar. 

Move the mouse pointer to the formula bar and click once to the right of 18. 

 

 

 

Use the Backspace key to delete 8,then type 4 and press Enter. Cell D4 now 

contains the value 14. 

 

Task 3: Replacing cell data 

 

Make the cell B5 active by clicking on it. 

Type 200 and press Enter. The cell B5 will now contain the value 200 replacing 

old value (150). 

 

Task 4: Deleting cell contents 

 

Move to cell C5 and click to select. Press 

the Delete key. 

The cell becomes blank. 



 

Drop down the Edit menu and click Undo to reinstate the 145. Excel 97 

allows 16 levels of undo. You can use Undo and Redo buttons also. 

 

Task 5: Copying data 

 

Open the cash spreadsheet. Select 

the cells D3 to D5 

Click Edit menu and then click Copy. Select 

the cells F3 to F5. 

Click Edit menu and then click Paste. 

Now the cells D3 to D5 are copied into F3 to F5. 

 

Task 6: Moving data 

 

Open cash.xls spreadsheet. Select the 

cells from B3 to B5. 

Click Edit menu and then click Cut. Select the 

cells G3 to G5. 

Click Edit menu and then click Paste. 

 

Task 7: Data Auto Fill 

 

There is an easy method to fill the data in columns and rows. The data may be 

Numeric or dates and text. 

 

To fill Slno by using auto fill 

Type Slno for 2 cells i.e 1,2 in the cells A1 and A2 respectively. Select two 

cells and drag the Fill Handle  

 



 

UNIT-III 



 



 



 



 



 



 

 



 



 

 



 

 



 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

PowerPoint 



 



 

 

Change Font Type 

To change the type of font for text within a slide, first select the text that you want to edit.  If you want to change the 

type of font for the whole presentation, first go to Edit> Select All.  This will select all the text.  

 Next, go to the box on the formatting toolbar that lists font types  In the example below, the box currently says Arial.

  

Change Font Size 

Select the text that you want to change.  Go to the font size box on the Formatting toolbar.  In the example above, 

the box currently has a 40 inside of it.  Select the new size and it will automatically be applied to the selected text. 

You can also use these two icons  to increase and decrease font size.  The larger A icon is used to 

increase size, with the smaller one being used to decrease it. 

 Change Font Color 



 

 To change the color of the font, select the text you want to change.  Go to the Formatting toolbar and click 

the  icon. Choose the new color.  It will automatically be applied to the selected text.  

Boldface 

 Boldfaced words appear darker than other words. 

 This is an example of boldfaced text. 

 To boldface text, first select the text.  Then click the  icon on the Formatting toolbar.  

Italics  

This is an example of italicized text.  

  

To italicize text, select the text and then click the   icon. 

  

Underline 

 To underline text, select the text and then choose the  icon on the Formatting toolbar. 

  

 

  

 

Slide Transition Animation in PowerPoint  

   You can add slide transition animation in PowerPoint to a single slide or to all slides at once. To do this, select the slide or 
slides to which you want to apply slide transition animation from the “Slides” pane. This pane appears at the left side of the 
“Normal” view. Then click the “Transitions” tab in the Ribbon. Then use the buttons and options in the “Transition to This Slide” 
button group to apply slide transition animation. 

            Click any of the available transition effects in the “Transition to This Slide” group. Then click the “Preview” button in the 
“Preview” button group to see the transition effect previewed in the slide window. After selecting a transition effect, set the 
properties of the transition using the “Effect Options” button within this button group. 

            You can change the transition effect speed. To do this, enter the amount of time to play the transition animation into the 
“Duration” spinner box. This spinner box appears in the “Timing” button group.            To play a sound during the transition, 
select a choice from the “Sound” dropdown in the “Timing” button group. To play a custom sound, select the “Other sound…” 



 

choice from the button’s dropdown menu. In the “Add Audio” dialog box that appears, navigate to the folder that contains the 
sound file to use. Then double-click to select it. It is important to note that the sound must be a “WAV” file type. 

            Next, in the “Advance Slide” section of the “Timing” button group, set how to advance the slide during your 
presentation. You can either advance the slide by mouse click and/or automatically advance the slide after a predetermined 
time interval. To advance to the next slide when you click your mouse button, ensure the “On Mouse Click” checkbox is 
checked. To automatically advance the slide, check the “After:” checkbox. Then enter a time duration into the small spinner 
box to the right. Also ensure the “Use timings” checkbox is checked in the “Set Up” button group on the “Slide Show” tab. 

            You can apply the selected transition to all presentation slides after applying it to the currently selected slide. To do 
this, click the “Apply to All” button in the “Timing” button group. 

Slide Transition Animation in PowerPoint: 

Instructions 

1. To apply slide transition animation in PowerPoint, first select the slide(s) to which you want to apply transition 

animation. 
2. These slides appear in the “Slides” pane at the left side of the “Normal” view. 
3. Then click the “Transitions” tab in the Ribbon. 
4. Then use the buttons and options in the “Transition to This Slide” button group to apply slide transition animation. 
5. Click any of the available transition effects in the “Transition to This Slide” group. 
6. Then click the “Preview” button in the “Preview” button group to see the transition effect previewed in the slide window 
7. After selecting a transition effect, set the properties of the transition using the “Effect Options” button within this button 

group. 

8. To change the animation speed, enter a duration, in seconds, into the “Duration” spinner box in the “Timing” 

button group. 

9. To play a sound during the transition, select a choice from the “Sound” dropdown in the “Timing” button group. 

10. If you want to play a custom sound, select the “Other sound…” choice from the button’s dropdown menu. 

11. In the “Add Audio” dialog box that appears, navigate to the folder that contains the sound file to use. 
12. Then double-click to select it. It is important to note that the sound must be a “WAV” file type. 

13. To advance to the next slide when you click your mouse button, check the “On Mouse Click” checkbox. 

14. This checkbox appears in the “Advance Slide” section of the “Timing” button group. 

15. To automatically advance the slide, check the checkbox for “After:” in the “Advance Slide” section of the 

“Timing” button group. 
16. Then enter a time duration into the small spinner box to the right. 
17. Also ensure the “Use timings” checkbox is checked in the “Set Up” button group on the “Slide Show” tab. 

18. To apply the selected transition to all presentation slides, click the “Apply to All” button in the “Timing” 
button group. 

Two ways to consolidate PowerPoint slides and save time 

 Reuse Slides 
 Custom Slide Show 



 

. 

 

Saving Your Presentation 

 

To save your presentation, choose Save As from the File menu. In the File Save dialog 

box, type the name you wish to give your presentation in the File name edit box, select 

the folder where you want it saved from the Save in drop down list, and click Save. If 

you’re going to open the presentation in another computer and want to make sure that 

text displays properly, click the Embed True Type check box. 

 

Opening a Presentation 

 

To begin working with PowerPoint by opening an existing presentation select Open an 

Existing Presentation from the PowerPoint startup dialog box and click OK. If 

PowerPoint is already running, choose Open from the File menu or click the Open button 

on the Standard Toolbar. From the File Open dialog box, select the folder where the files 

is located in the Look in drop down list, select the file from the Name box, and click 

open. 
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